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Mii lea EndNote? 
 

EndNote lea reaidu mii atno čohkket ja čorget referánssaid. 

Reaidduin lea ulbmil ráhkadit iežat referánsačoakkáldaga mas leat referánsat girjjiide, 

áigečállagiidda ja eará gálduide. 

Don sáhtát ieš čállit referánssaid EndNote:i, dahje viežžat daid Orias dahje eará dáhtabásain. 

Go referánsat leat vurkejuvvon EndNote:i, de sáhtát daid álkit atnit vuođđun go čujuhat 

(siteret), ja go ráhkadat gáldolisttuid Wordas. 

 

EndNote gávdno guovtti hámis: EndNote Desktop, ja EndNote Basic mii geavahuvvo neahta 

bokte. Go dán láidehusas namuhuvvo EndNote, de lea sáhka EndNote Desktop (EndNote 20) 

birra, ja lea prográmma mii installerejuvvo dihtorii.  

 

 

 

 

 

 

Sánit mat gusket čujuheapmái 

 

• Gáldu:    Referánsa (reference) 

• Gáldočujuhus:  Siteren (citation) 

• Importeret:   Viežžat/sisafievrridit (import) 

• Gáldovuorká:   Iežat gáldočoakkáldat EndNote:s (My EndNote Library) 

• Gáldohápmi:  Makkár hámis čujuhus ja gáldolistu šaddá dokumeanttas 

(Output style). Omd. APA 6th, APA 7th, Aigecala, Harvard  
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Vuolggahit EndNote 
 

EndNote vuolggahat dihtora prográmmaid bokte.  

Ovdamearkka dihte Windows 11:s : 

 

 

 

 

Dehe Worda bokte:  

 
 

 

Ráhkadit ja vurket EndNote-vuorkká 
 

Vuosttáš háve go rabat EndNote, de jerrojuvvo 

áiggot go ráhpat ovtta vurkejuvvon  

gáldovuorkká dehe ráhkadit ođđa: 

Ráhkat ođđa gáldovuorkká boaluin  

Create a new library 

 

Go áiggot ráhkadat ođđa EndNote-vuorkká  

ja vurket dan, de lea dehálaš ahte vurket dan  

iežat dihtorii (C:) it ge neahttabáikái nu go Dropbox, OneDrive ja eará, danin go dát sáhttá 

vahágahttit vuorkká. 

 

1. Deaddil File -> New... 

2. EndNote evttoha nama My EndNote Library,  

ja vurkensaji Dokumenter-máhppii  

(mii dábálaččat lea dihtoris [C:]:s vurkejuvvon).  

Deaddil Lagre (vurke) 
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EndNote-prográmmas leat guokte oasi: 

• fiila mas lea namma EndNote (EndNote.enl), ja 

• máhpa mas lea namma My EndNote Library.data. 

Jus áiggot sirdit EndNote-vuorkká eará báikái, de fertejit dát lea seamma máhpas amas 

EndNote galgá doaibmat. 

 

Mii ávžžuhit atnit dušše ovtta gáldovuorkká. Sáhtát bártidit jus vieččat gáldodieđuid 

iešguđet gáldovuorkkáin ovtta Word-dokumentii. Ane baicca juoguid EndNote:s (Groups) 

čorgen dihte. Geahča láidehusa siiddus 23 – Rádjat gálduid EndNote:s. 

Jus anát máŋga gáldovuorkká, geahča čilgehusa maŋemus siiddus movt dán čoavddát. 

 

 

 

Ođđa EndNote-vuorká masa  

eai leat vurkejuvvon gáldut: 

 
 

 

 

 

 

Mii ávžžuhit vurket sihkkarastinkopiija duollet dállet. Dan dagat ná: Raba EndNote, ja 

deaddil File -> Save a Copy. Vurke namain mainna álkit gávnnat jus dárbbašat. 

Don mearridat ieš gosa vurket dan, muhto gánnáha vurket báikái gosa muđui vurket čállosa 

mainna leat bargama nu ahte šaddá dáhpin vurket sihkkarastinkopiija iežat gáldovuorkkás.  

Don sáhtát maid vurket nu gohčoduvvon Compressed Library, mii lea smávit 

sihkkarastinkopiija masa mearridat mii galgá mielddusin: 

 

• Deaddil File -> Compress Library (.enlx)… 

• Vállje mii galgá mielddusin, ja deaddil Next 

• Vurke dihtorii gos muđui anát sihkkarastinkopiijaid  
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EndNote 20 hápmi 
 

 

 

 

1 – Váldomenya:  Dás leat buot EndNote:a funkšuvnnat. Muhtin funkšuvnnat gávdnojit 

maid eará sajis ikonaid botke 

2 – Juohkopanela:  Juogut masa EndNote-gáldovuorká lea ráddjojuvvon 

3 – Ohccánpanela:  Dás sáhtát ohccát dihto gálduid iešguđet ohccánbásain EndNote bokte 

4 – EndNote-vuorká: Obbalaš govva čohkkejuvvon dehe sirrejuvvon gálduide 

5 – Johtilisboalut: Siterenboallu, ođđa gáldu, juogadit máhppa/sirrejuvvon gálduid, 

eksporteret gálduid, ohccát dokumeantta neahtas (rabas hámis) ja 

ráhkadit siterenraporta 

6 – Ohccánfealta: Oza gáldu iežat gáldovuorkkás (álkis ja dárkilis ohccán) 

 

Guoská merkejuvvon gáldui EndNote-vuorkkás: 

7 – Rievdat: Rievdat gáldu 

8 – Gáldodieđut: Namahus, čálli, čoahkkáigeassu ja eará dieđut mat gusket gáldui 

9 – Ovdagihtiigovus: Go válljet dihto gáldohámi, de oainnát makkár dát šaddá gáldolisttus. 

Dárbbu dihte sáhtát maid kopieret teavstta. 
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Eksporteret gálduid iešguđet dáhtabásain EndNote:i 
 

 

 

 

 

 

 

 

 

 

 

Don gávnnat dáhtabásaid girjerádjosa 

neahttasiiddus http://samas.no/se/girjerajus/diehtovuorkkat  

 

 

Gálduin maid vieččat eará dáhtabásain sáhttet leat meattáhusat, váilevašvuođat dehe 

dieđut maid it háliit iežat gáldovuorkái EndNote:s.  

Danin lea dehálaš divvut daid dan seammás go vieččat daid: 

• Geahča makkár gáldun dát lea registrerejuvvon (girji, artihkal, neahttasiidu jnv.). 

• Geahča leat go buot dehálaš dieđut čuvvon, ja leat go rievttes sajis . 

• Lasit dehe sihko fáddásániid. 

 

Go sisafievrridat gálduid, de bidjá EndNote dáid máhppii gohčoduvvon Imported references, 

ja lassin máhppii “All references”.  Dalle lea dáid álkit gávdnat ja divvut. 

 

Mii ávžžuhit vuolggahit EndNote-prográmma ovdal go vieččat gálduid básain. 

  

http://samas.no/se/girjerajus/diehtovuorkkat
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Oria (Google Chrome bokte) 
 

1. Raba Oria neahttasiidu https://samall.oria.no , ja oza gáldu maid áiggot viežžat 

2. Deaddil siterenboalu (”) 

3. Deaddil EndNote-boalu 

Fuom! Ale deaddil EndNote Web 

Dát lea liŋka EndNote neahttareidui (EndNote Basic) 

 

4. Deaddil VURKE (divtte čállinmearkavuogádaga leat UTF-8) 

 

 

 

https://samall.oria.no/
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5. Vulogeahčen Chrome:s siiddus oaččut vejolašvuođa rahppát gáldu. Deaddil dan: 

 

 

 

Gáldu rahpasa EndNote juogus Imported References: 
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EBSCO Academic Search Elite 
 

EBSCO básaide (Academic Search Elite ja EBSCO eBook Collection) sisabeassamii gáibiduvvo 

leat Sámi allaskuvlla eduroam-neahtas dehe atnit eduVPN. 

1. Raba EBSCO Academic Search Elite, ja oza artihkkala maid áiggot vurket 

2. Deaddil artihkkala namahusa maid áiggut sáddet EndNote:i 

3. Deaddil Export olgešbeale 

 

 

 

4. Sihkkaraste ahte lea válljejuvvon Direct Export in RIS Format...(e.g...CITAVI, EasyBib, 

EndNote, ProCite...), ja deaddil Save 
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5. Vulogeahčen Chrome:s deaddilat delivery.ris:  

 

 

 

 

Gáldu rahpasa EndNote:s: 
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Google Scholar 

 
1. Raba Google Scholar neahttasiiddu (https://scholar.google.no/ ) ja oza gáldu maid 

áiggot vurket EndNote:i 

2. Deaddil “ Referanse: 

 

 

 

 

 

 

 

 

3. Govas mii ihttá deaddilat EndNote: 

 
 

4. Vurke gáldu boaluin scholar.enw vuollin neahttasiiddus: 

 

 

 

 

 

 

  

https://scholar.google.no/
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Web of Science  
 

Web of Science bása sisabeassamii gáibiduvvo leat Sámi allaskuvlla eduroam-neahtas dehe 

atnit eduVPN. Jus logget sisa iežat EndNote-konttuin, de sáhtát earet eará vurket 

ohccánbohtosiid. Geahča Ráhkadit EndNote Online-konttu (siiddus 36). 

1. Raba Web of Science neahttasiiddu, ja oza gáldu maid áiggot vurket EndNote:i 

2. Vállje artihkkala/artihkkaliid maid áiggot vurket EndNote:i, ja deaddil Export: 

 

 

 

3. Vállje EndNote desktop: 

 

 

 

 

 

 

 

 

 

4. Vulogeahčen Chrome:s deaddilat savedrecs.ciw: 

 

Referánssat rahppasit EndNote:s 
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Divvut gálduid 

 
Gálduin maid vieččat eará dáhtabásain sáhttet leat meattáhusat, váilevašvuođat  

dehe dieđut maid it háliit iežat gáldovuorkái EndNote:s.  

Danin lea dehálaš divvut daid dan seammás go vieččat daid. 

Jus áiggot divvut ovtta gáldu, de deaddilat Edit-boalu badjin olgešbeale, dehe CTRL+E.  

Divo váilevaš-/boasttudieđuid, ja loahpat Save-boaluin.  

• Jus menya olgeš bealde ii oidno, de deaddilat guovtte geardde gurutboalu sáhpánis 

(doala sáhpánboalu olgešbeale govas go deaddilat). 

• Don sáhtát stuoridit “divvungova” linjjáin mii lea gaskal váldogova ja divvungova: 

 

 

 

Sihkut gálduid  
 

Merke gálduid maid áiggot sihkut, ja deaddil Delete (Del). Gáldut maid sihkut biddjojuvvojit 

máhppii Trash. Jus áiggot oalát sihkut dáid, de deaddilat olgešboalu, ja válljet Empty Trash. 

Várut nu ahte it sihko gálduid maidda leat čujuhan Word čállosiin. 
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Sihkut duppalgálduid (Duplicates) 
 

Duppalgáldut leat dán oktavuođas jus dus leat máŋga (ovttalágan) gáldu vuorkkás mat 

gusket seamma girjái, kapihttalii, artihkkalii ja nu viidáseappot.  

 

Jus čálidettiin máŋgii čujuhat seamma čállosii, ja dán oktavuođas anát iešguđet gáldu vaikko 

lea sáhka seamma gáldu birra - de sáhttet dát vahágahttet čujuhusaid. 

Gáldolisttus sáhttá ovdamearkka dihte seamma girji leat guktii, ja sáhttá maid daguhit ahte 

gulahallan gaskal Word ja EndNote ii doaimma nu mo galgá. 

Dan dihte berret dávjá iskat leat go ovttalágan gáldut iežat vuorkkás, ja rádjat dehe sihkut 

daid maid it dárbbaš. 

 

Menyas válljet Library  -> Find Duplicates 

 

 

Vállje gáldu maid háliidat vurket, ja deaddil Keep This Record. Gáldu maid leat ovddemus 

viežžan/registreren iežat EndNote vuorkái lea gurutbeale dán govas. 
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Sirret gálduid maid oainnát All Referencesis dehe iešguđet máhpain 
 

Gáldovuorkká sirren lea automáhtalaččat čálli goarggus, muhto lea maid vejolaš sirret dáid 

namahusas dehe eará dieđus. Dán rievdadat jus deaddilat suorggi bajábealde gálduid. 

 

 

 

 

 

 

Stuora bustávat/smávva bustávat  
 

Jus gáldu namahusas leat stuora bustávat, de sáhtát dáid rievdadit.  

Merkes namahusa, deaddil Edit ja nuppes Change case -> Sentence Case: 
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Registreret gálduid manuálalaččat  
 

Gálduid maid it gávnna dáhtabásain sáhtát ieš registreret. Dát lea maid jus háliidat 

njálmmálaš gálduid registreret. 

1. Deaddil New references-boalu [+]: 

 

 

 

 

 

 

 

2. Vállje álggos gáldu dokumeantahámi (girji, artihkal, artihkal neahtas jnv.): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



19 
 

EndNote:s lea vejolašvuohta válljet gaskkal ollu dokumeantahámiid go registreret ođđa 

gáldu. Dá leat dat dábáleamos dokumeantahámit: 

• Book: Girji, raporta, čálus mas lea okta dehe máŋga čállit (monografiija) 

• Book Section: Oassi girjjis (kapihtal) 

• Edited Book: Girji mas leat máŋga čálli ja doaimmaheaddji(t) 

• Electronic Book / Article: Čálus mii lea neahtas 

• Journal Article: Áigečálaartihkal báberhámis 

• Web Page: Eará materiála neahtas 

 

Don sáhtát rievdadit dokumeantahámi maŋŋel go leat registreren gáldu. 

 

Go lean registrereme, de lea álkit sirddášit gáldu surggiid gaskkas:  

TAB: sirddášit vulos  

Shift + TAB: Sirddášit bajás 

ENTER: viiddidit dehe lasihit ođđa linjjá gáldosuorgái (omd. jus leat máŋga čálli) 

Fuom: Ale loahpat čuoggáin dehe ođđa linjjáin maŋobeallái teavstta ovtta gáldosuorggis. 

 

Author:  Álggos goargu, ja de ovdanamma (Goargu, Ovdanamma). 

Juohke čálli nama deavddát ođđa linjái. 

Čále olles ovdanama. EndNote oanida dán ovdabustávvan jus gáldohámis gáibiduvvo nu.  

Jus namma ii leat ovdalaččas devdojuvvon EndNote:i, de merkejuvvo ruoksádin: 

 

 

Jus dus leat gáldut main lea seamma čálli, de fertet deavdit justte seamma ládje juohke 

gáldus. 

 

Jus čálli lea organisašuvdna: Dán deavddát Author-suorgái.  

EndNote dulko persovdnanamman buot mii devdojuvvo dása, ja gáibida ahte lea 

devdojuvvon jorggu ládje (Goargu, Ovdanamma). Danin ferte organisašuvnnanama 

maŋobeallái bidjot rihkku amas EndNote ii jorgal dán teavsttas.  

Ovdamearkka dihte: “Sámi allaskuvla,”  
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Title: Deavddát čuoggá dehe eará mearkkaid haga. Ane duppalčuoggá (kolon) gaskkal váldo- 

ja liigenamahusa. Ovdamearkka dihte: Sámit, sánit, sátnehámit: riepmočála Pekka 

Sammalllahtii miessemánu 21. beaivve 2007 

Jus šattat divvut stuora bustávaid smávva bustávvan, geahča Stuora bustávat/smávva 

bustávat s. 5. 

Journal: Olles namahus áigečállagis devdojuvvo dása. Várut ahte leat konsekveanta smávva 

ja stuora bustávaiguin.  

Pages: Dása deavddát buot siidduid gáldus (1442-1449) dehe oaniduvvon (1442-9). Ale čále 

s. dehe p. merken dihte ahte leat siiddut. EndNote bidjá dán jus gáldohámis gáibiduvvo. 

Label: Dán diehtosuorgái sáhtát deavdit dieđuid mat čujuhit iežat arkiivasystemii dehe 

pearpmaide ja nu viidáseappot.  

Keywords: Fáddásánit. Fáddásánit gaskal lea vejolaš ohccát. 

Abstract: Dása deavddát abstrávtta čállosis dehe sáhtát maid importeret dán oktanis 

gálduin. 

Notes: Iežat dieđut ja notáhtat gáldui. 

Research notes: Dása sáhtát maid iežat notáhtaid deavdit. 

DOI: Digital Object Identifier. Bissovaš čujuhus elektrovnnalaš dokumentii neahtas. 

URL: Neahttačujuhus ovtta dokumentii. Dát sáhttá rievdaduvvot, ja danin berre atnit DOI jus 

lea e-girji dehe artihkal neahtas. 

File attachments: Gálduid mildosat nu go PDF- dehe Word-fiillat. Fiila kopierejuvvo, ja bidjo 

mielddusin gáldovuorkái. Buot maid vurket PDFan sáhtát maŋŋil ohccát.  

 

  

 

 

 

 

 

 

 

 

 

 

dehe 
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Dehálaš linjat mat galget devdojuvvot iešguđetlágán referánssaide 
 

Girji (Book) 
Author (Čálli(t)) Juohke čálli nama deavddát ođđa linjái. 

Year (Almmuhanjahki). 

Title (Namahus girjjis). 

Place Published (Almmuhanlágádusa báiki). Deavdde dušše dan vuosttáža jus máŋga. 

Publisher (Lágádus) Deavdde dušše dan vuosttáža jus máŋga. 

Edition (Girjji prentehushápmi). Dušše jus girji lea prentejuvvon ođđa hápmái. 

2nd, 4th jnv. jus leat eaŋgalasgillii čállime, ja 2., 4. jus leat sáme- dárogillii čállime.  

 

Kapihtal girjjis (Book Section) 
Čálli, almmuhanjahki, kapihttala namahus (Title), doaimmaheaddji (Editor), girjji namma 

(Book Title), almmuhanlágádusa báiki, lágádus, siiddut, girjji prentehushápmi (jus 

ođastuvvon) 

 

Áigečálaartihkal (Journal Article) 
Čálli, almmuhanjahki, artihkkala namahus (Title), áigečállaga namma (Journal), jahkodat 

(Volume), nummár (Issue), artihkkala siidologut (Pages), DOI. 

Jus áigečálaartihkal lea vižžojuvvon neahtas, de válljet Electronic Article dokumeantahápmin. 

Deavdde dalle: Čálli, almmuhanjahki, artihkkala namahus, čálaráiddu namma (Periodical 

Title), jahkodat, nummár, artihkkala siidologut, DOI dehe URL. DOI vuoruhuvvo.  

 

Girji mas ásahus dehe organisašuvdna lea čállin 
Dán registreret girjin (Book). 

Deavdde: Čálli (muitte bidjat rihkku maŋobeallái ásahusa/organisašuvnna amas ii jorgaluvvo 

teavsttas), almmuhanjahki, girjji namahus, URL. Jus girji gávdno báberhámis, de deavddát vel 

almmuhanlágádusa báikki (Place Published) ja lágádusa (Publisher). 

 

Eará dokumeanttat neahtas/neahttasiidduid (Web Page) 
Deavdde: Čálli, almmuhanjahki, namahus ja URL.  

Muitte vel deavdit goas dán leat viežžan neahtas (Access Date). Áigečála gáldohámis anát 

formáhta DD.MM.YYYY – omd. 23.06.2023. 

 
Lea jierpmálaš vurket kopiija dokumeanttaid maidda čujuhat čállosis. Neahttasiiddut sáhttet 

rievdaduvvot dehe jávkat. Dát ii gusto dieđalaš čállosiidda, lágaide ja eará almmolaš 

dokumeanttaide.  
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Oahppoplána neahtas 

 
Oahppoplána mii gávdno neahtas deavddát seamma ládje go neahttasiiddu. 

Ovdamearkan: 

 

 

 

 

Kildekompasset 
 

 

 

Jus registreret gálduid EndNote:i manuálalaččat, de ávžžuhit atnit neahttasiiddu 

www.kildekompasset.no.  

Doppe oainnát makkár dieđuid galggat deavdit iešguđet sadjái gáldus.  

 

Girjerádjosa neahttasiiddus https://samas.no/se/a/sa-birra/girjerajus/endnote-

callinravvagat gávnnat eará vuogas rávvagiid.  

http://www.kildekompasset.no/
https://samas.no/se/a/sa-birra/girjerajus/endnote-callinravvagat
https://samas.no/se/a/sa-birra/girjerajus/endnote-callinravvagat
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Rádjat gálduid EndNote:s 
 

 

Juogut (Groups) 
 

Jus áiggot sirret gálduid iešguđet fáttaide, čállosiidda dehe fágasurggiide, de sáhtát čohkket 

daid juoguide. Dáinna lágiin lea gáldovuorká eambbo čorgat, ja lea álkit sihke oaidnit ja 

gávdnat gálduid gáldovuorkkás. Don sáhtát bidjat ovtta gáldu máŋgga juhkui, ja okta gáldu 

mii lea ovtta juogus gávdno maid olles gáldovuorkkás (All References). 

 

Leat máŋga vuogit movt ráhkadat máhppa. Dá guokte ovdamearkka:  

1. 

• Merke guđe gálduid áiggut sirdit sierra máhppii. Doala CTRL-boalu siste jus merket 

máŋga gáldu. 

• Deaddil olgešboalu sáhpánis ja vállje Add References To ja nuppes  

Create Custom Group. 
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2.  

• Menyas Groups-boalu bokte.  

Čális nama juhkui. 

 

 

 

 

 

• Vállje gáldui seamma vugiin go vuosttaš ovdamearkkas. 

Deaddil Add References To, ja vállje juogu maid ráhkadit. 

  

 

 

 

Ohccát gáldovuorkkás 
 

Don sáhtát ohccát ovtta gáldu iežat vuorkkás. 

Jus válljet Advanced search, de oaččut vejolašvuođa ohccát dárkilit:  
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Word ja EndNote – Cite While You Write 
 

 

EndNote čatnasa Microsoft Wordain funkšuvnna botke mii gohčoduvvo  

Cite While You Write. Go vuos leat čohkken gálduid iežat EndNote-vuorkái, de dagaha dát 

funkšuvdna álkin čujuhit go leat čállime. Seammás go čujuhat ráhkaduvvo gáldolistu 

loahpageahčen dokumeantta. 

 

EndNote:s leat máŋga duhát gáldohámit mat mearridit movt čujuhusat ja gáldolistu 

hábmejuvvo go čujuhat áigečálaartihkkaliidda, girjjiide ja eará gálduide.  

Dábálaš gáldohámit leat omd. APA, Harvard ja Vancouver. UiT:a heivehuvvon Aigecala lea 

sámegillii. 

Go leat installeren EndNote, de lea Word menyas sierra EndNote-menya.  

Dá ovdamearkan - Office 365 Word:s 

 

 

 

Čujuhit Word čállosis 

 
Go áiggot čujuhit, de deaddilat Insert Citation-boalu bajágeahčen. (Boallu lea guovtti lahkis): 
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Oza čálli geasa áiggot čujuhit. 

Jus áiggot ohccát buot vurkejuvvon gálduin, de sáhtát čállit “a” ja deaddilit Find. 

Vállje rievttes gáldu, ja deaddil Insert. 

Vuolit oasis oainnát dieđuid gáldui. 
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Čujuhit máŋgga čálliide  
 

Jus don čujuhat máŋgga čálliide, de galget dát leat seamma ruođuid siskkobealde. 

Merke teavsttas gokko galggat čujuhit, ja deaddil Insert Citation. 

1. Čále “a” ohccánboksii ja oza vuosttaš čálli. Merke nuppi go vuos leat deaddilan Ctrl nu 

ahte goappašagat leat merkejuvvon 

 

 

Go dál deaddilat Insert, de galgába goappašagat leat ruođuid siskkobealde. Omd.: 
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Divvut gáldočujuhusaid dokumeanttas 
 

Go anát Word:a Cite While You Write čujuheapmái, de čuovuha EndNote kodaid iežat  

Word-dokumentii.   

Lea hui dehálaš ahte it vikka divvut gáldočujuhusaid dahje gáldolisttu nu mo dábálaččat 

dagat DEL- dehe Backspace-boaluin go dát sáhttá botket gulahallama gaskal EndNote ja 

iežat čállosa. 

 

Jus áiggot divvut dahje sihkut gáldočujuhusa, dagat ná: 

1. Deaddil gáldočujuhusa maid áiggot divvut dahje sihkut. Teaksta šaddá ránis: 

 

 

 

2. Deaddil Edit & Manage Citation(s)   

 

 

 

3. Dás sáhtát sihkut olles gáldočujuhusa (Remove Citation), čálli dahje jagi ruođu 

siskkobealde (exclude author/year), bidjat teavstta ovddabeallai/maŋobeallái ruođus (prefix 

ja suffix), ja bidjat siidologu gullevaš gáldočujuhussii (Pages): 
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Jus čálidettiin fuobmát meattáhusaid gálduin, de divut dáid álggos iežat EndNote-vuorkkás. 

1. Deaddil Edit & Manage Citation(s), [1] ja čuovvovaččat Edit Library Reference [2] 

 

 

2. Divo álggos gáldu EndNote:s (geahča siidu 15 Divvut gáldu,) 

3. Go leat divvon EndNote:s, de deaddilat Word:s  

Edit & Manage Citation(s) -> Update from My Library... 

 

Sihkut gáldočujuhusa dokumeanttas 
 

1. Merke čujuhusa maid áiggot sihkut, ja deaddil Edit & Manage Citation(s). 

2. Deaddil njuola olgešbeale Edit Reference ja vállje Remove Citation -> OK. 
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Siidologuid čujuhussii 
 

Jus áiggot siidologuid bidjat čujuhussii, de deaddilat Edit & Manage Citation(s). 

APA gáldohámis bijat siidologuid (dušše siffara/siffariid) Pages-linnjái: 

 

 

Harvard gáldohámis čálát siidologuid Suffix linnjái dán hámis: , p. 25  dehe , s. 25 

 

Harvard gáldohápmi 

APA ja Aigecala gáldohápmi 
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Rievdadit gáldohámi (Style/Output Style) 
 

EndNote:i gávdnojit ollu gáldohámit nu go APA, Harvard, Vancouver, Chicago jnv. 

Dáid rievdadat Word:s:  

 
 

 

Jus gáldohápmi maid áiggot atnit ii oidno listtus, de deaddilat Select Another Style 

 

 

Eanet gáldohámiid gávnnat earet eará UiT:a siidduin UiTs tilpassede referansestiler. 

Doppe lea ovdamearkka dihte Aigecala-gáldohápmi. 

EndNote siidduin https://endnote.com/downloads/styles/ leat maid ollu gáldohámit.  

 

 

  

https://uit.no/ub/skriveogreferere/endnote/sub?p_document_id=731353
https://endnote.com/downloads/styles/


32 
 

Viečča gáldohámi maid áiggot atnit.  

Go leat viežžan, de rabat fiilla vulogeahčen Chrome:s – omd.:.  

 

Dát ráhppása EnNote:s: 

 

 

Deaddil File, -> Save As...,  

 

 

Sáhtát oanidit nama ovdal go deaddilat Save 
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Sirddášit teavstta dokumeanttas dehe dokumeanttaid gaskka 
 

Jus áiggot sirdit teavstta dokumeantta siskkobealde dehe eará dokumentii, de lea ávkkálaš 

váldit eret formáhta (kodaid) maid EndNote bidjá go čujuhat. 

Dán dagat ná: 

Word:s deaddilat Convert Citations and Bibliography, ja válljet Convert to Unformatted 

Citations. 

 

 

Dalle šaddá teaksta ovdamearkka dihte ná: {Battiste, 2000 #263}. 

Dál sáhtát sirddásit teavstta.  

Go leat sirdán, de deaddilat fas Update Citations and Bibliography vai oaččut fas čujuhusa 

riekta oktan gáldolisttuin. 

 

 

 

Jus leat bargame stuora dokumeanttaiguin, de lea hui ávkkálaš dán metoda čuovvut duos 

dás vai čanastat gaskkal EndNote ja Word doaibmá.  
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EndNote formateren (Instant Formatting) 
 

Jus čujuhusain fuobmát dákkár hámi: {Battiste, 2000 #263}, de lea EndNote:a Instant 

Formatting jáddáduvvon. Dán bijat fas doibmii jus deaddilat Instant Formatting is Off 

 

 

Deaddil Turn Instant Formatting On.  

 

 

 
 

Sihkut kodaid Word dokumeanttas 
 

Ovdal go sáddet dokumeantta earáide, de gánnáha váldit eret buot kodaid maid EndNote lea 

bidjan dokumentii. Vurke dokumeantta ovdal go sihkut kodaid. Go kodat leat sihkkojuvvon, 

de lea čanastat EndNote:i botkejuvvon, ja de it sáhte daid šat viežžat.  

1. Deaddil Convert Citations and Bibliography 

 

2. Vállje Convert to Plain Text 

Dál báhcá dokumentii dušše teaksta. 
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Jus dus leat máŋga gáldovuorkká 
 

Mearrit guhte EndNote-gáldovuorká galgá rahppasit Word bokte dehe go eksporteret 

dáhtabásain:  

Raba iežat vuoruhuvvon gáldovuorkká EndNote:s. 

1. Edit -> Preferences -> Libraries 

2. When EndNote starts: vállje Open the specified libraries 

3. Deaddil Add open libraries 

4. Deaddil OK 
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EndNote Online 
 

Dus lea vejolaš ráhkadit EndNote Online-konttu mii addá vejolašvuođa atnit EndNote 

iešguđet dihtoriin beroškeahttá lea go dihtorii installerejuvvon EndNote prográmma.  

EndNote Online-kontu addá maid sisabeassama Web of Science dáhtabásii.  

 

 

Ráhkadit EndNote Online-konttu 
 

1. Sihkkarastte álggos ahte iežat dihtor lea Sámi allaskuvlla neahtas gohčoduvvon 

eduroam. Dás oainnát movt beasat dasa: Iešhálddašeapmi: Wi-Fi (vuollelis siiddus 

Movt logget sisa Eduroam-fierpmádahkii). 

 

2. Raba EndNote Online neahttasiiddu https://myendnoteweb.com , ja  

deaddil Register. 

 

 
 

  

https://samas.topdesk.net/solutions/open-knowledge-items/item/KI%200145/no/
https://myendnoteweb.com/
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3. Ráhkat ođđa EndNote Online-konttu: 

 

 

E-boastačujuhus 

Jus leat bargi: Ane iežat bargo e-boastačujuhusa  

Jus leat studeanta: Ane iežat priváhta e-boastačujuhusa  

 

Čoavddasátni 

EndNote gáibida ahte čoavddasánis leat eret eará dát dieđut: 

• unnimusat 8 čállinmearkka (eai ge eambbo go 95)  

• unnimusat okta lohkomearka (0-9)  

• unnimusat okta sierračállinmearkkain (!@$%& jnv.) 
 
Čoavddasánis eai berre leat čállinmearkkat q, w, y, x <, >, ¨, ‘ ja * go dát sáhttet buktit 

soahpatmeahttunvuođa tastaturain go molssut giela. 

 

Go leat ráhkadan konttu, de sáddejuvvo e-boasta dutnje mainna duođaštat ahte 

leat don gii leat ráhkadan dan. Dát e-boasta soaitá mannat spam-máhppii. 

  



38 
 

Ovdamearka: muitte dárkkistit meattáhusaid gáldolisttus 
 

 


